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error can be quantified by bounding the norm of
the error u − uh in terms of the mesh spacing h
of the finite element mesh. Such estimates have
the form ku − uh k ≤ C hq , where C is a problemdependent constant independent of h and the constant q indicates the order of convergence of the
FEM, as the mesh spacing h decreases. We see
from this form of the error estimate that we need
q > 0 for convergence as h → 0. More realistically, we wish to have for instance q = 1 for linear
convergence, q = 2 for quadratic convergence, or
higher values for even faster convergence.
One appropriate norm for FEM errors is the
L2 (Ω)-norm associated with the space L2 (Ω) of
square-integrable functions, that is, the space of
all functions v(x) whose square v 2 (x) can be integrated over all x ∈ Ω without the integral becoming infinite. The norm is defined concretely as the
square root of that integral, namely

Abstract: In order to gauge how reasonable a finite element solution to a partial differential equation is on a given mesh, a common strategy is to
refine the mesh, compute the solution on the finer
mesh, and use the solutions on the two meshes for
a qualitative comparison. The theory of the finite element method (FEM) makes these comparisons quantitative by estimating the convergence
order of the FEM error on a sequence of progressively finer meshes. We will show how to carry out
convergence studies of this type in the graphical
user interface of COMSOL 4.0 on the example of
Lagrange elements of varying polynomial degrees,
which will also bring out the benefit of using higher
order elements.
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Introduction

Z
kvkL2 (Ω) :=

The finite element method (FEM) is widely used
as a numerical method for the solution of PDE
problems, especially for elliptic PDEs such as the
Poisson equation with Dirichlet boundary conditions
−∆u = f
u=r

in Ω,

(1.1)

on ∂Ω,

(1.2)

1/2
v (x) dx
.
2

(1.3)

Using the L2 -norm to measure the error of the
FEM allows the computation of norms of errors
also in cases where the solution and its error do
not have derivatives. Lagrange finite elements
of degree p, such as available in COMSOL with
p = 1, . . . , 5, approximate the PDE solution at several points in each element of the mesh such that
the restriction of the FEM solution uh to each element is a polynomial of degree up to p in each spatial variable and uh is continuous across all boundaries between neighboring mesh elements throughout Ω. For the case of linear (degree p = 1) Lagrange elements, we have the well known a priori
bound (e.g., [1, Section II.7])

where f (x, y) and r(x, y) denote given functions
on the domain Ω and on its boundary ∂Ω, respectively. Here, the domain Ω ⊂ R2 is assumed to be a
bounded, open, simply connected, and convex set
in 2 dimensions with piecewise smooth boundary
∂Ω.
The FEM solution uh will typically incur an error against the PDE solution u of (1.1)–(1.2). This

ku − uh kL2 (Ω) ≤ C h2
1

provided u ∈ H 2 (Ω). The assumption on u is ensured if the right-hand side of the PDE (1.1) satisfies f ∈ L2 (Ω). We notice that the convergence order is one higher than the polynomial degree used
by the Lagrange elements. Analogously, a more
general result for using Lagrange elements with degrees p ≥ 1 is that we can expect an error bound
of [5, Section 6.2.1]
ku − uh kL2 (Ω) ≤ C hp+1 .

By selecting a test problem which has a known
PDE solution u, a direct computation of the error u − uh and its norm in (1.4) can be achieved.
The convergence order q is then estimated from
these computational results by the following steps:
Starting from some initial mesh, we refine it uniformly repeatedly, which subdivides every triangle
into four triangles. If h measures the maximum
side length of all triangles, this procedure halves
the value of h in each refinement. Let r denote the
number of refinement levels from the initial mesh
and Er := ku − uh kL2 (Ω) the error norm on that
level. Then assuming that Er = C hq , the error
for the next coarser mesh with mesh spacing 2h
is Er−1 = C (2h)q = 2q C hq . Their ratio is then
Rr = Er−1 /Er = 2q and Qr = log2 (Rr ) provides
us with a computable estimate for q in (1.4) as
h → 0. Notice that the technique described here
uses the known PDE solution u; this is in contrast
to the technique described in [2] that worked for
Lagrange elements with p = 1 without knowing
the PDE solution u.
In Table 1 we list for each refinement level r,
the number of elements Ne in the mesh, the degrees of freedom (DOF), the FEM error Er =
ku − uh kL2 (Ω) , the ratio of error for consecutive
refinements Rr = 2q , and the estimate Qr =
log2 (Rr ) for the convergence order computed as
described in the Introduction. As expected, the
computed error tends to zero as the number of
refinements increases. In addition for a given refinement level, the error is smaller for higher order Lagrange elements. We observe that through
p = 1, . . . , 5 the convergence order estimate Qr is
consistent with the predicted value q = p + 1.

(1.4)

The first purpose of this note is to demonstrate numerically that for an appropriate example this behavior can be observed for the Lagrange elements
with all possible orders p = 1, . . . , 5 available in
COMSOL; this is the contents of Section 3.3. The
second purpose is to explain in detail how to conduct these convergence studies in COMSOL 4.0.
An update of this note for COMSOL 4.0a and extension to using LiveLink for MATLAB is the topic
of [6].
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Elliptic Test Problem

In this section, we consider the classical elliptic
test problem on a polygonal domain, which can be
partitioned into the finite element mesh without
error. Specifically, we choose the square domain
Ω = (0, 1) × (0, 1) ⊂ R2 and supply the right-hand
side of (1.1) as
f (x, y) = −2π 2 cos (2πx) sin2 (πy)
−2π 2 sin2 (πx) cos (2πy),

(2.1)

and the homogeneous Dirichlet boundary condition of (1.2) as
r(x, y) = 0.
(2.2)
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Use of COMSOL 4.0

This problem has been chosen as it has the known
In this section, we demonstrate how to conduct the
PDE solution [4]
convergence studies from the previous section usu(x, y) = sin2 (πx) sin2 (πy).
(2.3) ing the GUI of COMSOL 4.0. For convenience, the
instructions for this process are divided into three
The test problem with (2.1) and (2.2) is appropri- subsections. In Subsection 3.1, the test problem
ate to demonstrate the convergence of the FEM will be solved up to the point of the default plot
for all possible orders p = 1, . . . , 5 of Lagrange created after solving it. Subsection 3.2 outlines the
elements in COMSOL, since the right-hand side post-processing of the solution including changing
f ∈ L2 (Ω), which guarantees that u ∈ H 2 (Ω). the appearance of the solution plot and computing
A larger study that extends convergence studies the FEM error by domain integration. Lastly in
of this type to non-smooth problems to demon- Subsection 3.3, we describe how to solve the same
strate the mathematical assumptions of (1.4) was problem repeatedly on progressively finer meshes
reported in [3].
to obtain the convergence study and how to mod2

mension page. In order to proceed, click the
Next button (right arrow) on the toolbar of
this page. The Add Physics page replaces the
Model Wizard in the center pane.
2. On the Add Physics page, expand the Mathematics branch (by clicking on the down arrow
to the left of the label) and then the PDE
Interfaces branch, and select the Coefficient
Form PDE node. Click the Add Selected button (plus sign below window). By default, the
number of dependent variables is one and the
variable name is u. Since this is the desired
setup for the problem, click the Next button
(right arrow).

(a)

3. Under the Select Study page, select Stationary
and click the Finish button (checkered flag) on
the toolbar of this page.
4. Before proceeding to establish the specifics
of the test problem, check to ensure that all
needed information will easily be displayed. In
the Model Builder window in the left pane of
the GUI, click the View Menu (upside down
triangle) on the toolbar and make sure that
Show More Options is properly checked; this
setting is saved from one COMSOL session to
the next, so once this is selected, COMSOL
will retain this selection for future restarts.

(b)
Figure 1: Elliptic test problem on polygonal domain: (a) extremely coarse mesh, (b) FEM solution.

5. In order to set up the desired domain, right
click Geometry 1 and select Square in the
Model Builder window. By default, this
will generate the desired square domain Ω =
(0, 1) × (0, 1) with one corner of the square at
the origin.

ify the solution process to obtain the convergence
studies for other degrees of the Lagrange elements.
This section also motivates the idea of saving the
entire solution process to an mph-file at the appropriate moment, so as to have it available for solving
again.
Start the GUI of COMSOL by typing comsol at
the Linux prompt or double clicking the COMSOL
Multiphysics icon on a Windows operating system.

3.1

6. In the Model Builder window in the left window pane, the right-hand side of the PDE can
be set by expanding the PDE branch and selecting the Coefficient Form PDE 1 node.
The center pane of the GUI specifies the general form of the equation currently selected as
ea

Solution in the GUI

∂2u
∂u
+da
+∇·(−c∇u−αu+γ)+β·∇u+au = f.
∂t2
∂t

Under Source Term, enter for f the expression
(-2*piˆ2)*(cos(2*pi*x)*sin(pi*y)ˆ2
+sin(pi*x)ˆ2*cos(2*pi*y)). Also, set the
Coefficient da to zero to recover a Stationary
problem. Leave the other coefficients as their
default values in order to establish the Poisson
equation of 1.1

This section gives step-by-step instructions how to
solve the elliptic test problem from Section 2 in
COMSOL’s GUI.
1. Once the GUI loads, under the Model Wizard Window in the central window pane of
the GUI, choose 2D on the Select a Space Di3

7. The desired boundary conditions of the test
problem can be generated by right clicking
the PDE branch in the Model Builder window in the left pane and selecting Dirichlet
Boundary Conditions. Select the Dirichlet
Boundary Condition 1 branch in the Model
Builder window, then in the Dirichlet Boundary Condition page in the center pane under
Boundaries, choose All boundaries under Selection.
8. Again in the Model Builder window in the
left pane, select the PDE branch and on the
PDE page in the center pane under Discretization (you might have to expand Discretization
first), choose 1 for the Element order. This establishes the degree of the Lagrange elements
used. By selecting the element order to be 1,
COMSOL will use linear Lagrange elements in
the finite element solution.

(a)

9. In order to generate the FEM mesh that will
be used to compute the FEM solution, first
right click the Mesh 1 branch under the
Model Builder window and select Free Triangular to establish the mesh. On the Free Triangular page in the center pane, under the Domains item, select for Geometric entity level
the selection Domain. Under the Mesh 1
branch, select the Size node and on the Size
page under Element Size, choose Extremely
coarse for the Predefined Elements Size. In
order to see the mesh being used, right click
the Mesh 1 branch and choose Build All. Figure 1 (a) displays the extremely coarse mesh
that will be used to compute the FEM solution. The number of triangular elements used
in this mesh can be determined by right clicking the Mesh 1 branch and choosing Statistics. For this domain and extremely coarse
mesh, the number of triangular elements are
26.

(b)
Figure 2: Post-processing of FEM solution:
(a) three-dimensional view of solution , (b) threedimensional view of error.

3.2

Post-Processing

Solving the problem in the GUI leads to the solution in a default plot shown in Figure 1 (b). A
more conventional way might be to present the solution in a three-dimensional view. This subsection gives instructions on how to post-process the
FEM solution obtained in the previous subsection
by changing the plot to a three-dimensional view
10. Now, compute the FEM solution by right and by computing the FEM error.
clicking the Study 1 branch under the Model
Builder window and selecting Compute. Al1. Under the Results branch of the Model
ternatively, one can click the green equal symBuilder window, expand the 2D Plot Group
bol above the Study page on the toolbar. Once
1 branch, right click on the Surface 1 node
the solution is computed, the degrees of freeand choose the Height Expression. This shows
dom which have been solved for can be seen
a three-dimensional surface and height plot
below the Graphics window in the Messages
of the FEM solution uh (x, y). The result is
tab, which is 20 for this coarse mesh using linshown in Figure 2 (a). The previous subsecear Lagrange (element order 1) elements.
tion specifically used linear (p = 1) Lagrange
4

elements to solve the problem, which means 3.3 Convergence Studies
that the FEM solution uh (x, y) is a flat patch
In this subsection, we make use of the steps dison each triangle of the mesh. This is clearly
cussed in Subsection 3.2 in order to carry out a
visible in Figure 2 (a).
convergence study. We repeatedly refine the mesh
2. In order to construct a plot of the FEM er- that was used to compute the FEM solution, reror u − uh , right click the Results branch compute the solution and its error norm, and then
and choose 2D Plot Group. This creates a copy all calculated error norms.
second plot group called 2D Plot Group
1. Refine the mesh by right clicking the Mesh 1
2. Right Click the 2D Plot Group 2
branch and under More Operations select Reand select Surface. This creates the node
fine. Under refinement, type 1 and rebuild the
Surface 1 under the 2D Plot Group 2
mesh by right clicking the Mesh 1 branch and
branch. Select this Surface 1 node and on
selecting Rebuild All. Again, check the statisthe Surface page under expression, type the
tics by right clicking the Mesh 1 branch and
formula for the error which is the difference
selecting Statistics. With one refinement,
between the PDE solution and the FEM sothe
number of triangular nodes has increased
lution: sin(pi*x)ˆ2*sin(pi*y)ˆ2-u. Then
by
a
factor of 4 to a total of 104 elements.
right click this Surface 1 node and select the
Recompute
the FEM solution under this reHeight Expression. Figure 2 (b) shows a threefinement
by
right
clicking the Study 1 branch
dimensional surface and height plot of the erand
selecting
Compute.
Once the solution is
ror.
computed, right click the Surface Integra3. The convergence studies of the FEM solution
tion node and select Evaluate and choose Tarely on the L2 (Ω)-norm Er = ku − uh kL2 (Ω)
ble 1 to add the result to the previous created
of the FEM error with the norm defined
table. Continue this process through several
in (1.3) with v = u R− uh . COMSOL can
refinements. The Results tab under the graphcompute the integral (u − uh )2 dx that apics window accumulates all results for Er2 over
pears in this norm definition; this integral
the course of these refinements.
is then the square Er2 of the desired error
2. After following the above procedure through 4
norm Er . To compute this integral, right
consecutive refinements, we can copy the data
click the Derived Values branch on the
for the squares Er2 of the FEM errors from the
Model Builder and select Surface Integration.
table under the Results tab into some other
Choose all domains under Selection on the
software, such as MATLAB, for further proSurface Integration Page. Below expression,
cessing. This is how the Er2 column in Table 1
type the square (u − uh )2 of the error as
was obtained. The remaining columns in this
(sin(pi*x)ˆ2*sin(pi*y)ˆ2-u)ˆ2. Click to
table can be readily computed using the quancheck mark the Description and label this
tites Rr and Qr defined in Section 1.
quantity by typing E rˆ2 to indicate that it
is the square of the norm of the error. Now,
Following the previous steps in this section proright click the Surface Integration node on
vides a convergence study for the Lagrange elethe Model Builder window and select Evaluate
ments of order p = 1. In order to perform converand New Table. The result of the computation
gence studies for higher order Lagrange elements,
is 0.0116 and shown in the Results tab under
start from the mph-file from the end of Section 3.2
the graphics area.
that was saved before any mesh refinements. From
4. It is useful to save the solution process as the File menu, choose Open to load the file. Once
a COMSOL mph-file at this stage before the file is loaded, expand the Model 1 branch,
mesh refinements to have it available as start- then select the PDE branch, and change the order
ing point later when considering higher or- of the Lagrange element being used under the Disder Lagrange elements. Under the File menu, cretization to a different order. By retracing the
choose Save As .... This will automatically mesh refinement steps of this section, the values
save as an mph-file and append the extension shown in Table 1 can be obtained for all degrees
mph to the chosen filename.
p = 1, . . . , 5.
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